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Basic Concepts: Overview
Movies consist of frames. Each frame consists of a background with actors in front of the 
background. The actors move along paths which start at a particular frame and end at some 
later frame. A path is the curve drawn through the positions of a specific actor in each 
frame. For example, if a man moves in a straight line from the left edge of the screen to the 
right edge over 20 frames, his path would be a line consisting of 20 points, each 
representing his position in a particular frame. The movie can contain an unlimited number 
of paths, and paths can move in front of or behind other paths.
ScreenCraze provides the environment where you assemble actors and backgrounds into 
movies. The environment is called the ScreenCraze editor.



Basic Concepts: The ScreenCraze Editor
The highly interactive nature of the ScreenCraze editor allows you to view your movies, 
while you are creating them, as they would finally appear.If you were creating a movie by 
hand, you would start with a painted background. Stacks of cels painted on a clear plastic 
would be available to you, each stack representing an actor in the movie. You would create 
the first frame of your movie by overlaying a single cel from each stack, with the 
background showing through the clear plastic. You would then photograph the resulting 
image. For the next frame, you would again start with the painted background and overlay it
with the next cel from each stack. You may shift the cel relative to its position in the previous
frame if the actor is moving over the background. You would continue in this fashion for each
frame in your movie; a tedious but inherently simple operation.
The ScreenCraze editor works in a similar fashion, except that you create the motion of 
each actor completely before starting the next. For example, if you wanted a dog to run 
across your background, chased by a cat, you would first create a path for your dog actor by
drawing a line from the left edge of your screen to the right. You would then specify the 
number of frames over which the dog runs across the screen. The fewer the number of 
frames, the faster the dog would seem to run (since you "flip" through 10 frames more 
quickly than through 20). The ScreenCraze editor automatically creates the required 
number of frames, duplicating the background in each frame, cycling through the cels from 
the dog actor, and overlaying each cel, slightly shifted from its position in the previous 
frame. This process simulates motion.
To add the cat's path, you would then step through the movie to the point at which the cat 
would logically enter the scene, and then repeat the above process. When you create the 
cat's path, the cat is automatically forced in front of all other actors in this frame. This can 
be changed later if you change your mind. With the ScreenCraze editor, you get constant 
feedback. The dog is still visible as you create the cat's path. When adding to your movies, 
you always see what you have previously created, making animation almost as simple as 
moving the mouse and clicking.
This concept of creating paths parallels that of a multitrack studio used in the music 
industry. A single musician can play several instruments in a song by recording the sound of 
each instrument as a separate track and then overlaying the tracks using a "mixer". The 
ScreenCraze editor is essentially a mixer that allows you to create several paths and 
overlay them to create movies.



Basic Concepts: The ScreenCraze Editor Paths
Paths are central to ScreenCraze. They determine:
- where an actor should appear in each frame
- which cel of the actor is displayed in the frame
- whether the actor appears in front of, or behind, other actors
Each path is associated with an actor. However, the same actor can appear in multiple 
paths. Hence, if you want to create an animation of a flock of birds, you only need one bird 
actor.
The ScreenCraze editor provides tools for creating paths. The tools line and free hand allow
you to create regular shaped paths quickly and easily. For more complex motion, such as 
people walking, the line tool allows you to create paths, and each node in the path can then 
be moved individually to create the movie a frame at a time.
In addition to creating paths, the ScreenCraze editor also includes tools you can use to 
modify existing paths. Entire paths or portions may be repositioned by simply clicking and 
dragging the mouse.



Basic Concepts: The ScreenCraze Editor Options
The more important options available in the ScreenCraze editor are:
Background
The background scenery for a movie is very important. The Background option changes the 
background for the movie.
Timing
The speed at which your movie plays is determined by the frame speed. For example, a 100-
frame movie playing at 10 frames per second will last 10 seconds. The same movie playing 
at five frames per second will last 20 seconds. The Timing option allows you to vary the 
frame speed for the movie.
Sounds
Sounds provide an enhanced atmosphere to a movie. The Sound option adds and deletes 
sounds to the movie.







ScreenCraze Editor Tools Window: Selection Tool
The Selection tool is used for selecting and moving paths and path nodes in the 
ScreenCraze editor.
Paths represent the motion of an actor through the frames of the movie. Paths determine 
where the actor appears in each frame, which cel of the actor is displayed in the frame and 
whether the actor should be in front of, or behind, another actor in the frame.
A path is represented by a line with several points, called nodes, along it. These nodes 
represent the instance of the actor in each frame. The current node is the instance of the 
actor in the current frame and is shown by the appropriate cel image of the actor.
To select a path simply click the left mouse button once on the path's actor and the path 
becomes visible.
The Selection tool can be used for the following:
To redisplay the Adjust Path dialog - use the selection tool and double click the image of the 
actor. This will allow you to change the number of frames in a path, or the acceleration or 
deceleration.
Since Text Actors consist of only one cel holding the Shift key and double clicking a text 
actor on screen will bring up a text edit box with the text of the current actor in it.
To move the entire path to another location on screen - click on the image of the actor and 
drag the path to the new location. To constrain this movement to be only horizontal or 
vertical, hold down the Shift key while moving the path. While moving paths, using the 
ctrl+arrow keys will move the cursor and the attached path one pixel in the direction of the 
arrow.
To change the position of the selected actor in the current frame - hold down the spacebar 
and click and drag the actor's image to the new position. Holding down the Shift key while 
moving the actor's image will constrain the movement to be only horizontal or vertical. 
While moving the actor, using the ctrl+arrow keys will move the cursor and attached actor 
one pixel in the direction of the arrow.
To change the cel image of the selected actor to another in its cel sequence - hold down the 
Shift key and press the left or right arrow keys. The Shift + Left arrow key sequence cycles 
backwards through the cels of the actor, while the Shift + Right arrow key sequence cycles 
forwards.
To change the position of any node along an actor's path - hold the mouse button down 
while the pointer is over the node and drag. Holding down the Shift key while moving the 
node will constrain the movement to be only horizontal or vertical. While moving the node, 
using the ctrl+arrow keys will move the cursor and attached node one pixel in the direction 
of the arrow.
You will notice that the cursor changes to four arrows pointing inward when your cursor is 
over a node. When you click to begin dragging the node, the cursor will change to four 
arrows pointing out.



ScreenCraze Editor Tools Window: Text Tool
This tool allows you to create text actors.
Selecting the Text tool displays a text editing box where you can enter and edit text.
Use the Attributes menu item in the Text menu to customize your text.
To resize the text edit box, position the pointer over any of the borders of the box and drag it
to the desired size.
To move the text edit box, position the pointer over the title bar at the top of the window 
and drag.
After entering the desired text, click on the Selection tool, or press the Esc key, to close the 
text box.
You will be asked to name the text actor. The default name of the actor is the first line of 
text in the text editing box.
The text is placed into memory as an actor, and is displayed in the Actor window. This allows
you to immediately start using one of the path tools to place the Text actor into your movie.
Text actors are placed into movies just like all other actors.



ScreenCraze Editor Tools Window: Straight Line Path Tool
This tool creates a straight line path.
Hold down the mouse button and drag the mouse to draw the line.
Holding down the Shift key while dragging out the line constrains the line to horizontal, 
vertical, or 45-degree angle directions. 
Using the ctrl+arrow keys,while the actor is attached to your cursor or while dragging out 
the path, will move the cursor and actor one pixel in the direction of the arrow. 
After releasing the mouse button the Adjust Path dialog box is displayed.



ScreenCraze Editor Tools Window: Freehand Path Tool
This tool animates an actor along a freely drawn path.
Position the cursor where you want the path to start. 
Hold down the mouse button and drag around the stage.
Release the mouse button to complete the path.
After releasing the mouse button, the Adjust Path dialog box is displayed.



ScreenCraze Editor Tools Window: Path To Front Tool
This option moves the selected path or part of the path one or more layers to the front. The 
following options are available with this tool:
Clicking on the Path To Front icon moves the entire path one layer closer to the front.
Double clicking on the Path to Front icon moves the entire path to the foremost layer.
Holding down the Shift key and clicking on the Path To Front icon moves the current node 
one layer closer to the front.
Holding down the Shift key and double clicking on the Path To Front icon moves the current 
node to the foremost layer.
Holding down the Ctrl key and clicking on the Path To Front icon moves the first node of the 
path to the current node one layer closer to the front.
Holding down the Ctrl key and double clicking on the Path To Front icon moves the first node 
of the path to the current node to the foremost layer.
Holding down the Alt key and clicking on the Path To Front icon moves the current node to 
the end of the path one layer closer to the front.
Holding down the Alt key and double clicking on the Path To Front icon moves the current 
node to the end of the path to the foremost layer.



ScreenCraze Editor Tools Window: Path To Back Tool
This tool pushes the selected path or part of a path one or more layers to the back. The 
following options are available with this tool:
Clicking on the Path To Back icon moves the entire path one layer to the back.
Double clicking on the Path To Back icon moves the entire path to the rearmost layer.
Holding down the Shift key and clicking on the Path To Back icon moves the current node 
one layer closer to the back.
Holding down the Shift key and double clicking on the Path To Back icon moves the current 
node to the rearmost layer.
Holding down the Ctrl key and clicking on the Path To Back icon moves the first node of the 
path to the current node one layer closer to the rearmost layer.
Holding down the Ctrl key and double clicking on the Path To Back icon moves the first node 
of the path to the current node to the rearmost layer.
Holding down the Alt key and clicking on the Path To Back icon moves the current node to 
the end of the path one layer to the back.
Holding down the Alt key and double clicking on the Path To Back icon moves the current 
node to the end of the path to the rearmost layer.



ScreenCraze Editor Player Window: First Frame
Clicking on this button rewinds your movie to its first frame.



ScreenCraze Editor Player Window: Previous Frame
Clicking on this button rewinds the movie one frame.



ScreenCraze Editor Player Window: Play Backward
Clicking on this button plays the movie backwards starting at the current frame.



ScreenCraze Editor Player Window: Play Forward
Clicking on this button plays the movie in the forward direction.



ScreenCraze Editor Player Window: Next Frame
Clicking on this button advances the movie one frame.



ScreenCraze Editor Player Window: Last Frame
Clicking on this button advances the movie to the last frame.



ScreenCraze Editor Player Window: Play To End/Continuous
Clicking on this button toggles between Play to End and Continuous Play. This feature takes 
effect in both the ScreenCraze editor and Full Screen Play environments and for both 
forward and backward play.
When Play to End is selected and the movie is played in the forward direction, the movie 
plays to the last frame and stops.
When the movie is played in the reverse direction the movie plays to the first frame and 
stops.
When Continuous Play is selected and the movie is played in the forward direction, the 
movie plays to the last frame and then starts playing over from the beginning. This 
continues indefinitely until the movie is stopped. 
When playing the movie backwards, the movie plays backwards to the first frame and then 
continues playing backwards from the last frame. This continues indefinitely until the movie 
is stopped.
A movie is stopped when the user presses the Esc key.



ScreenCraze Editor Player Window: Full Screen Play/Editor 
Play
Clicking on this button toggles between playing the movie in the ScreenCraze editor Play 
environment or in the Full Screen Play environment.
In the ScreenCraze editor Play environment, the movie plays within the editor's window. All
the tools and player controls remain visible while the movie is playing.
This is often used in editing, where it is useful to see controls such as the frame counter, 
while the movie is playing.
In Full Screen Play mode, the entire screen is filled with the animation. Windows, window 
borders, the menu bar, and anything else will be hidden. 
This is the mode you would use when presenting your movie.



ScreenCraze Editor Player Window: Frame Scroll Bar
This scroll bar reflects the frames of the entire animation. The number in the box on the 
scroll bar (called the Frame Counter box) is the frame number of the current frame.
Dragging the Frame Counter box along the scroll bar allows you to scroll through the frames 
of your movie. Holding down the Ctrl key while dragging the Frame Counter box prevents 
the frame from updating until you release the mouse button.
The Frame Scroll Bar is a percentage bar; clicking in the middle of the bar takes you to the 
middle of the movie, clicking three quarters of the way along the scroll bar takes you three 
quarters of the way through your movie. The Frame Counter box will move to the spot that 
you clicked on the scroll bar. 



ScreenCraze Editor Actor Window: Actor List Icon
Click on the down arrow at the top of the Actor window to display a drop down list with the 
names of all actors currently loaded into memory.
Click on the desired actor's name in list.
The selected actor will now be displayed in the preview area. You can animate the actor in 
the preview area by clicking on the Play/Pause button at the bottom right corner of the Actor
window.



ScreenCraze Editor Actor Window: Disk Icon
Clicking on the Disk icon displays the Open Actor dialog box, allowing you to retrieve any 
actor from disk.
Select the actor file you wish to load, then click on the Open button.



ScreenCraze Editor Actor Window: Trash Icon
Clicking on the Trash icon deletes the selected actor from memory. 
A warning is displayed if you attempt to delete an actor that is being used in the movie.



ScreenCraze Editor Actor Window: Flip Vertical Icon
Clicking on the Flip Vertical icon flips the actor in memory vertically. This will affect all the 
paths that use the actor.
If the actor is not flipped back to its original state before the movie is saved, the modified 
actor will automatically be saved embedded in the movie.
In order to flip a text actor the ScreenCraze Editor must first convert it into a bitmap image. 
Once this is done, the text actor cannot be edited using the Edit menu item under the Text 
menu.
Before the conversion is performed, a message will be displayed informing you that it must 
be converted. This gives you the opportunity to abort this operation in case you selected the
flip button by accident or you changed your mind.



ScreenCraze Editor Actor Window: Flip Horizontal Icon
Clicking on the Flip Horizontal icon flips the actor in memory horizontally. This will affect all 
the paths that use the actor.
If the actor is not flipped back to its original state before the movie is saved, the modified 
actor will automatically be saved embedded in the movie.
In order to flip a text actor the ScreenCraze Editor must first convert it into a bitmap image. 
Once this is done, the text actor cannot be edited using the Edit menu item under the Text 
menu.
Before the conversion is performed, a message will be displayed informing you that it must 
be converted. This gives you the opportunity to abort this operation in case you selected the
flip button by accident or you changed your mind.



ScreenCraze Editor Actor Window: Play/Pause Actor 
Preview Icon
This button toggles the previewing of the current actor in the actor window. When playing, 
the current actor is previewed in the actor window. When paused, the current actor is only 
shown frozen in the actor window.



ScreenCraze Editor Menus: File Menu
The commands under the File menu allow you to start a new movie, open an existing movie,
save a movie, and exit ScreenCraze.



ScreenCraze Editor Menus: File New
This command creates a new untitled movie of one frame for you to work with.
A Purge Actors dialog box will appear if there are any actors currently loaded. Choosing to 
purge the actors will release them from memory.



ScreenCraze Editor Menus: File Open
This command displays the Open Movie dialog box which allows you to select a movie from 
disk.
A Purge Actors dialog box may appear. Selecting to purge the actors will release them from 
memory.



ScreenCraze Editor Menus: File Save
This command saves the current movie as a non-embedded file. This saves the movie under
the filename last selected in the Save As dialog box; the version on disk is overwritten. 
If the movie has not been previously saved, choosing the Save command prompts you with 
the Save Movie As dialog box. You can name the movie and select the directory where you 
want the movie saved. (See Save As for an explanation of the other available options in the 
Save As dialog.).
When using the Save command the background and actors are saved with the movie by 
default (this is an embedded format). In cases where a number of movies are all using the 
same actors, significant savings in disk space can be achieved by saving your movies in a 
non-embedded format. This means that instead of saving actors and the background, the 
movie simply stores the name of the file it needs and all relevant information.
Any actors not saved as individual movie components (for example actors that have been 
flipped in memory or bitmap actors) are automatically embedded in the movie whether save
embedded has been chosen on not.



ScreenCraze Editor Menus: File Save As
This command displays the Save Movie As dialog box which allows you to specify a new 
name for the copy of the movie you want to save and the location you want to save it in.
The Save As command allows you to save your movie in one of two formats:
Save Embedded
Saves a copy of the movie with all the components the movie requires; all the actors, and 
the background is embedded in the movie.
This is useful for movies that you intend to distribute or transfer to another machine. Save 
Embedded saves everything relevant to the movie in one file.
Save Non-embedded
(the Embedded feature on the Save Movie As dialog box is turned off)
Generally, Save Non-embedded saves only the filenames of the actors and the background, 
resulting in smaller file sizes. However, those actors that were modified or created during 
the session are also saved with the movie.
Saving actors and the background individually and using them as shared components in a 
number of movies is the recommended method of saving under normal circumstances. This 
method results in the efficient use of disk space.
Using the Non-Embedded option to save a copy of the movie resets the Save command so 
that the next time the Save command is selected, you will be prompted with the Save Movie
As dialog box. This prevents the non-embedded movie from accidentally being overwritten 
by the Save command. The Save command always uses the default embedded format.
Compressed
You also have the option of turning on image compression. This will save the files in an RLE 
compressed format which decreases load and save times as well as reduce the amount of 
disk space used.



ScreenCraze Editor Menus: File Exit
This command exits the ScreenCraze Editor.
If there are any changes not previously saved, you are prompted to save them before you 
exit the ScreenCraze editor.



ScreenCraze Editor Menus: Edit Menu
Although ScreenCraze is compatible with Microsoft Windows 3.0, the ScreenCraze editor 
does not use the Windows Clipboard for the Cut, Copy or Paste commands described below. 
Instead, the ScreenCraze editor uses its own special paste and delete buffers for these 
commands. You can not paste items in these special buffers to another application; nor can 
you copy data from another application and paste it into the ScreenCraze editor.



ScreenCraze Editor Menus: Edit Undo
When you select this command, the ScreenCraze editor will undo your most recent action 
(if possible). This feature makes it easier for you to experiment with the placement of paths. 
If you delete a path and decide you don't like the result, select the Undo command to 
change it back.
The Undo menu item changes to reflect the last editing function performed. For example, if 
you use the Edit/Cut command to delete a path, the Edit menu will now contain the Undo 
Path Cut menu item.



ScreenCraze Editor Menus: Edit Cut
This command cuts the selected path out of the movie and places it in the ScreenCraze 
editor's paste buffer.



ScreenCraze Editor Menus: Edit Copy
This command copies the selected path into the ScreenCraze editor's paste buffer.



ScreenCraze Editor Menus: Edit Paste
This command pastes the most recent path that was cut or copied to the ScreenCraze 
editor's special paste buffer into the movie starting at the current frame.
After choosing the Paste command, the path being pasted will attach itself to the cursor. 
Click the cursor at the position in the current frame where you want the path to start.



ScreenCraze Editor Menus: Edit Delete
This command removes the selected path from the Movie and puts it into the ScreenCraze 
editor's special delete buffer.



ScreenCraze Editor Menus: Text Menu
The Text menu contains commands used in conjunction with the Text tool from the Tools 
window. With Text/Attributes, the attributes affect all text in the actor you are currently 
creating. They will also become the default attributes for any Text Actors created afterwards.



ScreenCraze Editor Menus: Text Attributes
This command displays the Text Attributes dialog box which allows you to set display 
attributes for the selected text. These attributes are:
- Typeface - this list box contains the names of typefaces available on your system.
- Size - this lists the point sizes available for your system typefaces. You may also type in the
desired point size.
- Style - this lists the style options you can apply to your text. The available options are: 
Bold, Italic and Underline.
- Alignment - this allows you to align your text as left justified, center justified, or as right 
justified. A check mark is placed beside the current alignment setting.
- Word Wrap - When this feature is selected (a check mark appears beside it), text typed in 
the text entry box, using the Text tool, automatically wraps to the next line when it reaches 
the rightmost edge of the text box.
When word wrap is not selected, text stays on one line until you press the Enter key. This is 
useful when creating large titles that you want to scroll horizontally across the screen.
The default setting is Word Wrap on.
- Color... - this button displays the Select Color dialog box (showing the current color 
palette). You can then specify the color in which your text will appear. Click on the desired 
color and then click the OK button.



ScreenCraze Editor Menus: Text Edit
This command displays the Edit Text Actor window containing the current text actor.
You can then edit or modify the text. While the Edit Text Actor window is displayed, you can 
also select the Text/Attributes command and change the attributes of the text. See the 
Attributes command described above.



ScreenCraze Editor Menus: Options Menu
The commands under this menu allow you to set the background for the movie, the frame 
play rate of the movie, set the sounds for a movie and the sequence mode for the cels of 
new paths. The mode selected determines whether the cels are animated in a forward, 
backward, or ping-pong direction, or whether they remain still.



ScreenCraze Editor Menus: Options Background
This command allows you to change the background of the movie.
You can choose from three sub-menus: Picture, Color Fill, and Gradient. Each of these 
options will set a new background into the movie.
Selecting Event/Background/Picture displays the Open Background dialog box to retrieve a 
Picture file from disk. Backgrounds can be saved to a file format with the filename extension
.BMP, .DIB, .GIF, or .PCX.
Your background picture will be tiled over the movie's background.
Selecting Event/Background/Color Fill displays the color palette, and allows you to create a 
background using any single color you pick. 
Selecting Event/Background/Gradient allows you to create a gradient background from the 
colors you specify in the gradient dialog box, chosen from the palette displayed.
Gradient backgrounds created using this option are saved in memory.
Double-click on a color in the color palette to add colors to your gradient.
You can repeat the above step more than once to add different colors to your gradient. The 
preview box in the upper left corner of the window displays the current gradient.
Click on the line on the Direction dial to set the direction for the gradient. The direction for 
the gradient is restricted to 90-degree angles.
Click on Remove All to clear the gradient range.
Click on Remove Color to remove the selected color, which is selected by clicking on the 
color in the selected color list. 
Click on Dither Colors to use a dither pattern to blend between adjacent colors in the 
gradient. This is effective for eliminating the sharp edges between colors that lead to 
banding.
Click on Blend Colors if you want to use intermediate colors to blend between adjacent 
colors in the gradient. Blend Colors is most effective when working in 256-color mode.
With smaller palettes, it may yield unexpected results.
Gradients created in the ScreenCraze editor are saved as structures, and not as bitmaps. 
This means that they require only a fraction of the disk space normally needed to save a 
bitmap.



ScreenCraze Editor Menus: Options Timing
This command allows you to change the playback speed of your movie. Animation speed is 
measured in frames per second, and you set the rate by typing a number into the Frames 
Per Second edit box in the Timing dialog box.
While the Timing option allows you to set the speed at which the movie is run (in number of 
frames per second), the event is constrained by the complexity of the movie and the 
limitations of the hardware. The more complex a movie is, the slower it runs.



ScreenCraze Editor Menus: Options Sound
This command allows you to add a sound to any frame of your movie -- if you have sound capability on your 
system. ScreenCraze supports wave and midi sound formats. Selecting this command will bring up the Sounds 
dialog box.
In the Sounds dialog box you can open a wave or midi sound by clicking on the appropriate Open button. The sound
file will then appear in the Loaded Sounds box. 
You can preview any sound you have opened by selecting it in the Loaded Sounds dialog box, and clicking on the 
Play button.
You can remove a sound that you have opened by selecting the sound in the Loaded Sounds dialog box, and then 
clicking on the Remove Sound button.

To attach a sound to a frame of the movie:
Use the frame scroll bar in the Movie Player window to select the frame you want to add the sound to (This can be 
done with the Sounds dialog open). 
The current frame, and any sound attached to it, are displayed in the Frame box of the Sounds dialog box. 
In the Loaded Sounds box, select the sound that you want to attach.
Click on the Add to Frame button to attach the sound to the current frame. There can only be one sound per frame.

If you want to remove a sound form a movie, scroll through the movie until the frame containing the sound you 
want to delete is displayed in the Frame box.    Then click on the Remove from Frame button. You can cause the 
selected wave sound to play repeatedly by enabling the Loop Wave Sound check box.

You can end a sound that plays over several frames, early by attaching the appropriate Kill Sound event to the frame 
you want to end the sound at. The Kill sound commands are located in the Loaded Sounds box and are attached to a 
frame the same way a sound is.

NOTE: Not all sound drivers will support both types of sound (wave and midi). Some sound support will not play 
sounds overtop of the animation, but will suspend all movement while playing the sound. In this case, the Loop 
Wave Sounds, and Kill Sounds options will not work. 



ScreenCraze Editor Menus: Options Cel Sequence Mode
This command displays a sub-menu which allows you to set the default cel sequence for 
new paths. The cel sequence is the sequence in which the cels of an actor are displayed 
along the path. 
Select Forward to animate the actor in a forward motion along the path. The path loops from
the actor's first cel to its last and back to its first cel again.
Select Reverse to animate the actor in a reverse motion along the path. The path loops from
the actor's last cel to its first and back to its last cel again.
Select Ping-Pong to animate the actor in a ping-pong or back-and-forth motion along the 
path. The path loops from the actor's first cel to its last and then backwards to its first cel 
again.
Select Still to display only one cel of the actor along the path.
This menu item sets the default sequence for new paths only.



ScreenCraze Editor Menus: Options Screen Settings
This command displays the Screen Settings dialog box which allows you to select the type of
graphics display and resolution for your screen. 
You can alternatively set a custom screen definition by clicking on the Custom button and 
setting the number of horizontal and vertical pixels, the number of color bits per pixel, and a
choice of monochrome or color display.



ScreenCraze Editor Menus: Options Purge Unused Actors
This command removes all unused actors from memory.



ScreenCraze Editor Menus: Frame Menu
This menu deals with the frames that comprise your movie. It allows you to add or delete 
frames.



ScreenCraze Editor Menus: Frame Add
This command allows you to add one or more frames (as specified in the Add Frames dialog 
box) before or after the current frame. Adding frames does not affect the number of nodes 
in the path.



ScreenCraze Editor Menus: Frame Delete
This command allows you to delete a specified range of frames. Selecting the Delete 
command displays the Delete Frames dialog box which allows you to specify the range of 
frames you want deleted.
You can use the two scroll boxes to specify the start and end frames of the range to be 
deleted; alternatively, you can drag the scroll boxes to increase and decrease the frame 
numbers.
When the Delete Frames dialog box is displayed, both numbers are set to the current frame. 
Leaving both numbers unchanged deletes the current frame only.
You cannot set the End Frame number to less than the Start Frame number.
When you choose the Start and End Frames, the deletion is inclusive (that is, all frames 
between the two numbers, including the Start and End Frames, will be deleted).
If the Display Start Frame button is turned on, the specified Start Frame is displayed in the 
ScreenCraze editor window.
If the Display End Frame button is turned on, the specified End Frame is displayed in the 
ScreenCraze editor window.



ScreenCraze Editor Menus: Path Menu
The Path menu provides a variety of tools that can operate on the selected path in your 
movie. 
All of the options in this menu are unavailable until a path is selected.
Paths are selected by either clicking on the actor associated with the path.



ScreenCraze Editor Menus: Path Adjust
This command displays a dialog box which allows you to set the total number of frames for 
the path, the acceleration at the beginning, and the deceleration at the end.
Enter the number of frames over which you want the actor to reach normal speed in the 
Accelerate for first edit box.
The illusion of an actor speeding up is achieved by starting with the actor's path nodes close
together and gradually spreading them out over the number of frames you specify.
Acceleration is known as easing-in, because it allows an actor to ease-in to its motion in a 
natural way rather than looking like it jerked into motion.
Enter the number of frames over which you want the actor to slow to a stop in the 
Decelerate for last edit box.
The illusion of an actor slowing down is achieved by starting with the actor's path nodes far 
apart and gradually decreasing the spacing over the number of frames you specify.
Deceleration is known as easing-out, because it allows an actor to ease-out of its motion in a
natural way rather than coming to an abrupt stop. 
Properly accelerating and decelerating actors gives their motion more realism.
Click on the To End button to automatically calculate the number of frames from the current 
frame to the end of the movie.
Clicking on To End only calculates the number of frames to the end of the movie at the 
current time. If you were to add more frames subsequently, and wanted the path to extend 
to the new end, you would have to re-select the Path/Adjust command, and click on the To 
End button again.
Click on OK to confirm your selections.
Clicking OK in the Adjust Path dialog box redistributes the frames along the path according 
to the settings you have made. While the line that defines that path will not be altered, the 
individual cels along the path will be redistributed regardless of how they were created. Path
Freezes, for example, will no longer be in place after you adjust the path.
Click on Cancel to exit without redistributing the path.



ScreenCraze Editor Menus: Path Freeze
This command allows you to freeze the current position and cel of the actor for a specified 
number of frames. This is done by inserting additional nodes in the path. Hence the path is 
actually extended.
Tip
Selecting Adjust from the Path menu after using the Freeze feature will redistribute the 
frames along the path and eliminate the effect of the freeze.



ScreenCraze Editor Menus: Path Go To Start
This command makes the first frame of the selected path the current frame.



ScreenCraze Editor Menus: Path Go To End
This command makes the last frame of the selected path the current frame.



ScreenCraze Editor Menus: Window Menu
This menu controls which windows (Player, Tools, Actor, Status) are displayed on the 
ScreenCraze editor workspace and also how the windows are displayed.



ScreenCraze Editor Menus: Window Arrange
If any of the ScreenCraze editor windows have been moved from their default positions, 
the Window/Arrange command returns the windows to the default positions.



ScreenCraze Editor Menus: Window Player
This command toggles the display of the Player window on and off. A check mark beside the
command indicates that the window is displayed.



ScreenCraze Editor Menus: Window Tools
This command toggles the display of the Tools window on and off. A check mark beside the 
command indicates that the window is displayed.



ScreenCraze Editor Menus: Window Actor
This command toggles the display of the Actor window on and off. A check mark beside the 
command indicates that the window is displayed.



ScreenCraze Editor Menus: Window Status
This command toggles the display of the Status bar on and off. A check mark beside the 
command indicates that the status bar is displayed.



ScreenCraze Editor Menus: Help Menu
The commands under this menu display on-line help information and copyright information 
about the program.



ScreenCraze Editor Menus: Help Index
Help/Index, will bring up a window with a list of the different subjects available for help. 
Clicking on a heading in the index will bring up more information about that topic.
Some of these topics are also listed in the Help menu itself. This allows you to jump directly 
to that topic without going through the Index. For more information on using the Help menu,
select Help/Using Help.



ScreenCraze Editor Menus: Help About ScreenCraze Editor
This command displays copyright information about the ScreenCraze Editor. The version 
number of the program is also displayed. Please have this number at hand when calling or 
writing to the Technical Support department.



ScreenCraze Editor Shortcut Keys
Miscellaneous
Screen scroll Arrow keys, Page Up, Page Down, Home, End

Tools Window
Text tool Shift+Ctrl+A

Actor Window
Open actor file Ctrl+O

Priority
While selecting either priority tool:
Step entire path through priority layers. Priority Tool Button
Change priority of entire path to extreme first
or last layer. Double Click on Priority Button
Step only current node through priority layers. Shift+Priority Button
Change priority of only current node to extreme
first or last layer. Shift+Double Click on Priority Button
Step path from current node to end of path
through priority layers. Alt+Priority Button
Change priority of current node to end of path to
extreme first or last layer. Alt+Double Click on Priority Button
Step path from beginning of path to current node
through priority layers. Ctrl+Priority Button
Change priority of beginning of path to current
node to extreme first or last layer. Ctrl+Double Click on Priority Button

Player Window
Toggle Full Screen/Edit Play Shift+Alt+F
Toggle Continuous Play (loop) mode Shift+Alt+L
Play forward Shift+Alt+P
Stop play Esc, Shift+Alt+P (in Edit Mode)
Go to first frame Shift+Alt+Home, Shift+Alt+Up Arrow
Go to last frame Shift+Alt+End, Shift+Alt+Down Arrow
Go to next frame Shift+Alt+Right Arrow
Go to previous frame Shift+Alt+Left Arrow
Advance 10 frames Shift+Alt+Page Down
Rewind 10 frames Shift+Alt+Page Up
Quick movie scroll with player window film
scroll bar (screen not updated until done) Hold down Ctrl while dragging frame 
number box

Paths & Nodes
Delete selected path Delete
Duplicate a path Ctrl+Click and drag path's actor
Change cel face Shift+Right Arrow, Shift+Left Arrow
Constrain line path to 45 degree angles Hold Shift or Right Mouse Button while 
dragging
Go to the frame of a specific path node. Ctrl+Click on node
Delete current node Ctrl+Delete
Move actor's current node Space+Click and drag actor
Display Adjust Path dialog for a path Double Click on paths actor
Display Text edit box for a path with



a text actor Shift+Double Click on path's actor




